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Helpdesk
Our Photoshop pro tackles your editing woes and sets 
you on the path to image enlightenment    BY JULIE EASTON

PERFECT KEYLINES
 I am relatively new to Photoshop CS and I 
want to know how I can add a keyline around 
the outside of my finished artwork. This 
seems to be such a simple thing to do, but I 
can’t work out a way of doing it. 
Simon Holmes

 
The simplest way to add a keyline to an image is to go to 
Edit>Stroke. You can pick the size, colour and position of 
the stroke from the dialog box that comes up. If you want to 
enter a value in centimetres rather than pixels, type the value 
followed by ‘cm’ and Photoshop will convert that value into 
pixels. The only problem with this method is that you have 
to sacrifice the edges of your image. You can get around this 
by using a different method. Open your image and then go 
to Image>Canvas Size. Enter a value that is double the width 
of the keyline you require (this is because it will add half the 
value to the top and half to the bottom), and make sure that 
the background colour is set to whatever colour you wish 
your keyline to be. This will give the appearance of a keyline, 
without any loss of picture. 

“THERE ARE A NUMBER OF TYPES 
OF DISTORTION .PRESENT IN 
ARCHITECTURAL IMAGES”
STRAIGHTEN IT OUT

 I’m not really a photographer, but I really 
need some photographs of old buildings to 
incorporate into my design work. All my 
attempts thus far have resulted in noticeable 
distortion. Rather than having to go back out 
and shoot all my source images again, will 
the Lens Correction filter in Photoshop help 
straighten things out?
Carrie Turner

There are a number of different types of distortion that are 
likely to be present in architectural images and often these 
will only show up once you start using the Lens Correction 
filter. The most obvious form of distortion in this type of 

photograph is keystoning, where you get converging verticals 
and the top of the image appears wider than the bottom. This 
happens because you are often pointing the camera upwards 
in order to capture the top of the building. To correct this, use 
the Vertical Perspective slider. Once you have done this you 
may find that your image suffers from bad composition, with 
the building itself not quite vertical. The Straighten tool will 
help you to sort this out (it’s the second button down on the 
left-hand side of the Lens Correction dialog). Finally, you can 
sort out any barrel distortion that has become apparent. This 
is done using the Remove Distortion slider. You will have to 
make all these adjustments a little at a time, so that you can 
see the effect. Going over the top will only make things worse. 

SHAKE IT
 I’m looking at buying a new camera and as I 
do a lot of action photography I want a good 
image-stabilisation system. However, I don’t 
know whether I am better going for a lens-
based system, or a sensor-shift system. Which 
gives better results?
Thelma Harris     

  It is hard to say whether one system gives better results than 
others. Sensor-shift technologies are relatively new and it is 
unlikely that many professional photographers have tried 
both in order to give an accurate comparison. Also sensor 

ADDING A KEYLINE:  Use the Edit>Stroke command to add a keyline to your image, or extend the canvas size to preserve the 
whole of an image

ARCHITECTURAL WOES:  The Lens Correction options 
can look overwhelming, but they can really help sort out 
problems common with architectural images
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HELPDESK
CALL FOR QUESTIONS

Want help with your Photoshop problems? 
Then let our team of experts sort you out. 

Send your emails to us at: 
advancedpshop@imagine-publishing.co.uk

Remember to specify whether you are 
using a PC or Mac and the version number 

of your edition of Photoshop. 

shifting is less common on high-end cameras, though this is 
beginning to change. There are advantages to both methods, 
but one thing to consider is whether you will be purchasing 
a number of different lenses and whether you are likely to 
upgrade often in the future. Lens-based systems mean that 
they will work with any compatible body, whereas sensor-
shift solutions should give the same level of stabilisation 
whatever lens you use with one body. It is better to take into 
consideration other factors of a new camera, such as high 
ISO settings, wide shutter speed range, continuous shooting 
capabilities and sturdy build, all of which are important in 
action photography. 

NEW COMPUTER
I really need to upgrade my four-year old 
computer to meet the demands of my 
image-editing work, but working for myself I 
am trying to stick to a tight budget. Which 
features are the most important for image-
editing tasks?
John Barrow

One thing that you don’t want to scrimp on and yet is often 
overlooked is the screen. CRTs are becoming a thing of the 
past and you are likely to get an LCD with your new computer 
purchase. Most budget PCs come with a 15-inch screen, and 
this really isn’t going to cut the mustard for heavy-duty image 
editing. We recommend investing in a 17-inch or 19-inch 
model for a better working area. Another important factor 
is the viewing angle, which you want as wide as possible in 
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 CUT IT OUT

 I’m very frustrated. I just sat there cutting out 
an image. It took me about an hour, only to 
notice that I have a very fine line around it, 
which is still showing the previous 
background. I want to know how far to take 
it? I work to a very fine zoom, where I can 
see every pixel. How do I know if the pixel 
belongs to: a) the image I’m cutting out, or 
b) the background? I want to cut out a man standing at a 
bus stop and I want a very precise cut.  It’s really awkward sometimes, especially when an 
hour of your life goes down the tin.
StudioWorks, on the forum

 
 This question was posted on the Advanced Photoshop forum. Plenty of you jumped at the chance to help out, with some 
great tips that other readers could benefit from. Trinity-of-one suggests that you Ctrl-click (or Cmd-click on a Mac) to load 
its selection. Then go to Select>Modify>Contract, entering a value of 1px. Feather the selection with a 1px radius and click 
on the Layer Mask button at the bottom of the Layers palette. This should give a smoother blend and the mask can be 
undone if it goes wrong. Garry79 adds that you could introduce a brightly coloured layer between the cut-out and the 
background to see the outline more clearly. We think that these are top tips and show exactly why the forum is so useful.

SHAKE IT:  The new Sony Alpha 
DSLR uses sensor shifting to 
stabilise images

ON A BUDGET:Check out PC World for great value PCs, 
where you can refine your search to suit your needs

b) the background? I want to cut out a man standing at a 

order to be able to view the whole of your image accurately. 
Make sure that you invest in a good screen calibration kit to 
ensure perfect colours. There’s a lot of talk about dual-core 
processors at the moment and you’ve probably seen this in 
your hunt for a PC. However, we feel that for your needs this 
is less important, as it is there to allow you to do two things 
at once, whereas single processors backed up by enough 
memory will cope just as well. Look instead for the most RAM 
and Hard Drive memory that you can afford. Images and 
Photoshop files take up gigabytes of space, and will slow 
your computer down if there’s not enough room for them all. 
Finally don’t worry too much about getting a high-power 
graphics card; unless you’re a hardcore gamer, you probably 
won’t see the benefit. Once you’ve got your base computer 
sorted, use any left over cash to invest in essential peripherals, 
like a good printer, graphics tablet and spare Hard Drive, all of 
which will make your new PC more efficient.   

SUPERSIZE GRAPHICS
 I  love working with a graphics tablet, as it 
allows me to be more creative with my work. I 
want to invest in a new tablet, as my A4 one 
is just not big enough anymore. I get carried 
away and end up running my pen off the 
edge of the screen. What options do I have 
for upgrading?
Dominique Turner  

Wacom really are your best option for graphics tablets. The 
Intuos range goes up to A3, which may be enough for your 
needs. However, we think that a great option is the new Cintiq 
21UX, which offers a different way of working for graphic 
designers and image editors. The tablet is a whopping 21 
inches, and acts as both a screen and a tablet. What this 
means is that you draw directly on your display, rather 
than on a separate tablet. You won’t find a bigger 
working area in the world of tablets yet, but we can see 
this being a popular solution. It is more expensive than 
standard tablets, though, and if price is an issue you 
should take a look at the large-scale A3 tablet instead.

HERE’S A TIP:The new Cintiq 21UX gives a new 
way of working for tablet lovers
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pgrading your PC is a minefield of 
technical terms and incompatible 
standards, and this is particularly 
true when it comes to graphics 

cards. Years ago it was all fairly simple – PCs 
came with chipsets that allowed them to 
display basic 2D graphics and little else. But 
with the release of 3D-capable games 
consoles, new companies appeared offering 
advanced 3D add-on cards, and eventually 
these also replaced the 2D chipsets. 

Today’s graphics cards are powerful processing 
units with as much on-board RAM as the average 
home PC, but the trouble is there’s such a huge 
amount of choice that it can be difficult to know 
what to look for, and the situation isn’t helped by a 
plethora of confusing jargon and obscure, 
meaningless model numbers. 

Although there’s a great variety of models, there 
are only two brand names really worth considering 
– Nvidia and ATi. Other makes such as Matrox and 
3D Labs were once major contenders but now 
produce specialist hardware that isn’t intended for 
general home use. 

The differences between Nvidia and ATi are 
largely irrelevant for most of us. There was a time 

U
when Nvidia had more stable drivers and generally 
faster hardware, but ATi’s software and hardware 
caught up a while ago and now they’re an equal 
match. Both are embroiled in a constant battle to 
get one-up on the other to the point where every 
month or two a new ‘world’s fastest’ graphics card 
will be announced, only to be bested a short time 
later by the other company.

When it comes down to it though, you can’t tell 
the difference between two cards of a similar 
specification in most situations once they’re 
plugged in without running benchmarking 
software, so your choice is going to be decided by 
whichever happens to offer the best features or 
value to suit your needs at the time. 

Manufacturers license the designs from the two 
companies and produce their own products based 
around the chipsets, which can result in two cards 
with the same base design that differ wildly in 
price, performance and features. Some will be 
optimised for performance with large high-speed 
fans, more memory, faster clock speeds and a 
higher price tag to match, while others could be 
fitted with silent heatsinks to reduce the noise of 
your internal components or might have less RAM 
to bring down the price. 

You’ll also find that the same model from 
different manufacturers can have different outputs 
and inputs, but unless you’re planning on editing 
video it isn’t likely to be of much concern – though 
there are now graphics cards out there that support 
HDCP, meaning they’ll let you output protected 
high definition content once it becomes available 
(and assuming the rest of your system also 
supports HDCP). 

Embellishments and extras aside though, pay 
particular attention to the clock speed of the GPU, 
memory and memory speed and also the number 
of pipelines, as this defines how powerful the 
hardware will be. The general rule is usually the 
higher the number the faster the card, but as with 
many things relating to PC hardware this doesn’t 
always prove to be true, so it’s worth doing some 
investigating to compare benchmarking results.

You’ll often find sub-£100 cards with engine 
clock speeds that compare to pricier models, but 
the difference will be the number of pipelines and 
the amount and speed of memory. And although 
there are cards with 1GB RAM, you don’t need to 
worry about buying something with that amount 
unless you’re planning on doing some serious 
gaming and want a card that’s future proof. Right 
now 256 or 512MB is quite sufficient for most users.

Before rushing out to buy anything, though, you 
need to decide what you want to do with your new 
card and how much you’re willing to spend. 

If you’re into gaming at all, you’ll want to be 
looking at mid-to-high-end cards with plenty of 
memory and fast clock speeds, and it goes without 
saying that aside from specific requirements like 
particular types of inputs or outputs, these will also 
be more than sufficient for handling other tasks like 
graphics and video work – there are some geared 
toward video editing which include accessories 
such as breakout boxes with extra connections. 

But if you’re not concerned about game 
performance or don’t have specialist requirements, 
you can save a great deal of money by looking at 
the lower end of the market. If you use Photoshop, 
browse the web and do some word processing, 

 FIRST DECIDE 
WHAT YOU WANT 
TO DO WITH YOUR 

NEW CARD 

graphics
cards
graphics
cards
graphics

Need a new one? You might be surprised at how much money you can save… 

GRAPHICS CARDS
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Gigabyte Nvidia
7950 GX2

Web: www.gigabyte.com.tw
Best Froogle price: £368.94 / $545.99

 Specifications
Core clock: 500MHz
Memory: 1GB GDDR3
Memory speed: 1200MHz
Connections: 2x DVI, TV-out, 
HDTV support

there’s absolutely no need to buy high-spec 
graphics hardware because even the cheapest 
standalone card is more than capable of driving 
Windows. If you don’t use any apps that need the 
rapid processing of 3D visuals, the more expensive 
products are a waste of money. 

If you’re on a really tight budget you might 
consider using the built-in graphics chipsets that 
are included on many systems (usually found in 
cheap mass-produced units), but the reality is that 
while it may sound tempting you’re better off 
spending a little on a cheap dedicated card. For 
one thing, these on-board graphics processors 
utilise the system memory, which can take quite a 
chunk off the available RAM and have an impact on 
the performance of memory-hungry applications. 
Another concern is that they’re not capable of 
reaching high resolutions and so are unable to 
drive larger monitors – something which could be 
a real hindrance for designers using the latest 
generation of widescreen displays. 

We can’t stress enough, though, how important 
it is not to spend money on hardware you don’t 
need. Don’t be fooled by the marketing and flashy 
packages on high-end graphics cards. Unless you’re 
a gamer or have some other specific need for a 
computer that can crunch complex 3D imagery, a 
powerful graphics card is a waste of money.

One final point to remember is to take the rest of 
your system into consideration. A shiny new card is 
wasted if your processor is old or you don’t have 
enough hard disk space or RAM – the slower 
components will simply cause a bottleneck. Make 
sure the rest of your system is also up to the job of 
handling whatever tasks you have in mind, and 
make components like the processor and memory 
a priority before considering the display. 

Also remember that there are currently two 
types of interfaces for graphics cards found on 
motherboards, so you’ll need to make sure you buy 
the correct type. AGP – Accelerated Graphics Port – 
is the older type and still very common. If your 
system is a few years old, chances are you’ve got 
one of these. PCI-Express is the newest interface 
and is now standard; any system bought in the last 
year or so is very likely to support PCI-E. AGP is not 
compatible with PCI-E and vice versa, so make sure 
you buy the correct type or you’ll have to waste 
time returning and exchanging the part. 

If you don’t have either of these connections on 
your motherboard, you will have the older PCI 
connection which is also used for many other 
expansion cards – but if this is the case we’d 
recommend buying a new computer. PCI cards are 
still readily available on eBay and other sources, but 
you’re far better off upgrading the entire system. 

 EVEN THE CHEAPEST 
STANDALONE CARD IS MORE THAN 
CAPABLE OF DRIVING WINDOWS 

Graphics cards
ROUND UPROUND UP

Web: www.msi.com.tw
Best Froogle price: £248.16 

 Specifications
Core clock: 450MHz
Memory: 256MB
Memory speed: 1320MHz
Connections: 2x 2x DVI, TV-in/out, HDTV support

MSI Nvidia NX7900GTX

SLI and 
Crossfire
You will very likely notice the terms 
‘SLI’ and ‘Crossfire’ being thrown about 
in reference to graphics cards. This is 
another thing that non-gamers can 
safely ignore. Both are technologies 
(SLI is Nvidia, Crossfire is from ATi)  
for running two or more cards in 
parallel, so that the processing is 
shared across all of them in order to 
give much greater performance. 
Obviously though, this doubles the 
cost because you have to purchase two 
cards – not to mention the fact that 
you must also have an SLI or Crossfire-
capable motherboard which has two 
PCI-Express slots.
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If you take two graphics cards with roughly 
similar specifications and run them side by 
side, you’d be hard pressed to notice any 
kind of difference. Assuming they support 
the same technology, the image is going 
to look much the same. So to properly 
test graphics cards, benchmarking tools 
are used which push the hardware to its 
limits, recording the results and allowing 
you to compare it to other cards. Some 
benchmarks are comparative, like the 
well-known 3DMark, producing scores 
which are meaningless unless sat next 
to results from other hardware using the 
same application. For more realistic, and 

arguably useful, results we use real-world 
tests, which are done by recording the 
frames per second (FPS) of a recent game 
to demonstrate the actual performance of 
a graphics card. It’s usually only hardware 
and gaming fanatics or reviewers who use 
benchmarks, but if you want to bench test 
your own hardware you can do so easily 
and for free. The basic 3DMark application 
can be downloaded for nothing from www.
futuremark.com, and you can use an 
application such as FRAPS, found at www.
fraps.com, to display and record the FPS 
of any game. However, you will find that 
many titles include that capability already, 
usually activated by a command-line switch 
or in-game command.

Benchmarking

Web: www.msicomputer.com
Best Froogle price: £83.70 / $155.08

 Specifications
Core clock: 587MHz
Memory: 256MB GDDR3
Memory speed: 1386MHz
Connections: 2x DVI, TV-in/out, 
HDTV support

MSI ATi X1600XT

Web: www.msicomputer.com
Best Froogle price: $164.03

 Specifications
Core clock: 625MHz
Memory: 512MB GDDR3
Memory speed: 1500MHz
Connections: 2x DVI, TV-in/out

MSI ATi 
RX1800GT

graphics
cards
graphics
cards
graphics

Web: www.msicomputer.com
Best Froogle price: £83.70 / $155.08

SpecificationsSpecifications
Core clock: 587MHz
Memory: 256MB GDDR3

MSI ATi X1600XT

Web: www.gigabyte.com.tw
Best Froogle price: £331.81 / $513

 Specifications
Core clock: 650MHz
Memory: 512MB GDDR3
Memory speed: 1600MHz
Connections: 2x DVI, TV-out, 
HDTV support

Gigabyte ATi 
X1900XTX

Web: www.pny.com
Best Froogle price: £51.65 / $72.99

 Specifications
Core clock: 550MHz
Memory: 256MB DDR2
Memory speed: 533MHz
Connections: DVI, TV-out, HDTV support

PNY Nvidia 7300GS
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Graphics cards
ROUND UP

Web: www.gigabyte.com.tw
Best Froogle price: £43.99 /
 $73.09

 Specifications
Core clock: 400MHz
Memory: 256MB
Memory speed: 500MHz
Connections: DVI, VGA, TV-out

Gigabyte 
ATi X550

Jargon
AA
Anti-aliasing is a way of reducing ‘jaggies’ 
in computer-generated images. While it 
can smooth out jagged edges to give a 
smoother, more natural image, this does 
result in some blurring and increases the 
strain on the graphics card. 

AGP
Accelerated Graphics Port. Interface 
designed specifically for graphics 
cards to replace the general-use PCI 
connection. AGP offers much higher 
speeds than PCI and these cards are still 
very common. You can easily pick up a 
powerful AGP card for less than £100.

Dual-link
Some newer widescreen monitors have 
very high resolutions, but you need a 
graphics card that supports dual-link 
connection. If you plan on driving a 30” 
display, make sure your graphics card 
and monitor cable are both dual-link.  

GPU
Graphics Processing Unit. This is the 
processor at the heart of every graphics 
card, and it’s designed to handle complex 
graphics processing tasks. The core clock 
or core frequency tells you the speed of 
the GPU on a particular card.

RAM
Random Access Memory. Just like the 
RAM in your PC, graphics cards use RAM 
to temporarily store data. The more you 
have the more info can be shunted there, 
speeding up load times and performance.

PCI
Peripheral Component Interconnect. An 
interface designed by Intel, this has been 
in use for many years now and is still the 
standard connection for sound boards, 
video adaptors and other expansion 
cards. PCI graphics cards are still 
available but not as common as AGP.

PCI-Express
Intended as a replacement for PCI and 
AGP, it’s currently only used for graphics 
cards. It has a far higher bandwidth than 
other interfaces, so all the new high-
performance graphics cards support it. 
Any new system should have at least one. 

Web: www.gigabyte.com.tw
Best Froogle price: £119.99 / $99

 Specifications
Core clock: 500MHz
Memory: 256MB DDR2
Memory speed: 800MHz
Connections: DVI, VGA, TV-out

Gigabyte Nvidia 
6600GT

Web: www.msicomputer.com
Best Froogle price: £51.27 / $77.17

 Specifications
Core clock: 600MHz
Memory: 256MB
Memory speed: 800MHz
Connections: DVI, VGA, TV-out

MSI ATi X1300 Pro

Graphics cards
ROUND UP

Graphics cards
ROUND UP

Graphics cards

 www.gigabyte.com.tw
Best Froogle price: £43.99 /

SpecificationsSpecifications
Core clock: 400MHz
Memory: 256MB
Memory speed: 500MHz
Connections: DVI, VGA, TV-out

Gigabyte Gigabyte 
ATi X550

Jargon
AA
Anti-aliasing is a way of reducing ‘jaggies’ 
in computer-generated images. While it 
can smooth out jagged edges to give a 
smoother, more natural image, this does 
result in some blurring and increases the 
strain on the graphics card. 

AGP
Web: www.msicomputer.com
Best Froogle price: £51.27 / $77.17

MSI ATi X1300 Pro

Web: www.msicomputer.com
Best Froogle price: £121.48 / $174.90

 Specifications
Core clock: 500MHz
Memory: 256MB GDDR3
Memory speed: 1530MHz
Connections: 2x DVI, TV-in/out, HDTV support

MSI Nvidia NX7600GT
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